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Overview 
This document is provided by NETGEAR to give you an understanding of the networking 
process and to make it easy for you to set up your own computer network. It describes the step-
by-step procedures for installing a network card and configuring a network. All of the information 
applies to PCs running Windows 95, 98, Me, 2000 Professional, XP Home, and XP Professional 
operating systems. It will help you install a PCI network adapter or a PC-card/PCMCIA card for 
a notebook computer. 

 

Step-by-Step Networking: Choosing Names and Protocols for 
Your Computer/Workgroup 
Communication between computers is very similar to communication between people. In a 
communication, you usually address a person by name. (Example: "John, can you please meet 
with..."). You also can address everybody within a group by a group name. (Example: "Please, 
students, all of you should be back by...").  
 
In the same way, your networked computers and workgroups need assigned names in order for 
anyone to communicate with them. You will need to identify your computer by a "Computer 
Name" and the groups of computers connected together by a "Workgroup" name.  
 
Also, you need to agree on a communication language. (It's safe to assume that you understand 
English since you are reading this information, but would you understand: "Bitte legen Sie die 
Diskette ein", which is German and means "Please, insert the Floppy Disk"?) Every PC on the 
network needs to understand the language your network is "speaking". 

Assigning Computer and Workgroup Names 
You will need to identify your computer by a "Computer Name" and the groups of computers 
connected together by a "Workgroup" name. 
 
First, both names are limited to a maximum of 15 alphanumeric characters plus a few special 
characters, such as " _ "  and " $ ". You must not use a space between any characters, as in: 
 

(Wrong:) "John Smith"  

(Right:) "JohnSmith"  

 
Be sure to keep it simple and short: 

 Although 15 characters are allowed, only use a maximum of 8 characters 
 Use only A through Z (in UPPERCASE) and 0 through 9 
 Avoid using the symbol ( $ ), which has special features to hide a system file 

 
Make sure that the "Computer Name" is unique -- defined only on one computer. (Imagine in a 
discussion between humans if you said, "Dave, please tell me..." when there were two or more 



Dave's present, who then both responded at the same time.) To avoid confusion, every 
computer must have a different name than the others. 
 
Make sure that no Computer Name is identical to a Username! 
 
Also make sure that the Workgroup name is the same on all connected computers to make it 
easy to communicate between them. (Microsoft proposed in Windows Me to use MSHOME.) 
 
To display the dialog box for assigning computer names and workgroup names: 
 

1. Select Control Panel from either the drop-down menu on your Windows Start menu, 
or by double-clicking the My Computer icon on your desktop.  

2. Click the Network icon. Or you can right-click the Network Neighborhood icon on 
your desktop, then select Properties. 

3. Click on the Identification tab. (In Windows 200 and XP, the tab is called Network 
Identification.) 

Setting Up Protocols  
Definition: Protocol  = Communication Language 
 
It is important now to discuss the selection of the type of Ethernet networking. You can compare 
this to deciding whether you'd like to communicate with a friend (who is far away) by making a 
phone call or sending a letter via postal mail or sending an e-mail. But you also need to 
communicate in a language that you will both understand, such as English, Spanish, French, 
German, or Chinese, for example. 
 
As with human languages that evolved thousands of years ago in different parts of the world, 
different networking "languages" (protocols) were developed during the "Computer Stone Age" 
(an amazing 30 years ago) by different companies and organizations. 

Network Properties  
Windows (95/98/ME/2000) supports the three most important and most used network protocols: 
IPX/SPX, NetBEUI, and TCP/IP, as shown below: 
 

 
 
As of Windows XP, Microsoft only supports two protocols: IPX/SPX and TCP/IP. (NetBEUI is 
now an "unsupported Protocol".)  



NetBEUI  
The NetBEUI protocol was originally developed by IBM, then later adopted by Microsoft for their 
first networking product, "Microsoft LanManager". Very simple to install (there is nothing to 
configure and it works as long as the computer name and workgroup name are properly 
defined), it is a very fast protocol, but it is not routable. This means it cannot be used to connect 
networks that are in different locations. This is a serious limitation for use in large companies, 
but its simplicity makes it a perfect choice for small home networks. Windows XP no longer 
supports it.  

IPX/SPX  
The IPX/SPX protocol was originally developed by NOVELL for their Netware server product. 
 
Netware was the first affordable PC-based fileserver (long before Microsoft entered this market 
with their Windows NT server product). In the first versions of Netware you had to use the 
IPX/SPX protocol to connect a PC to the Netware server (in the latest versions of Netware, 
TCP/IP protocol also is now supported). To enable the connection of Windows PCs, Microsoft 
implemented an "IPX/SPX compatible" protocol. IPX/SPX protocol requires very little 
configuration when connecting to a Netware or NT server, but on networks without a server you 
need to manually configure the frame type. 
 
IPX/SPX is routable and can be used to create large professional networks, connecting multiple 
sites. It is not often used in home networks unless explicitly required, as by some computer 
games. 

TCP/IP  
Originally developed for the ARPANET (which later evolved into the Internet), TCP/IP was at 
first only implemented on UNIX systems. It can be quite complex such as: IP address, subnet 
mask, gateway, router, DNS, or DHCP. Due to the explosive growth of the TCP/IP-based 
Internet in recent years, TCP/IP has become more and more the most important protocol used 
in most networks. 
 
TCP/IP works only with an IP address assigned for each system. If you have only Windows 
98/98SE/Me systems, you have the option to let Windows automatically assign itself an IP 
address. Also, all NETGEAR routers, Firewalls, and Print Servers come pre-configured to be 
DHCP (Dynamic Host Control Protocol) servers. This means that they will assign IP addresses 
for you on your network automatically! 
 
Although you could install all protocols (which will most probably work), you are strongly advised 
to install as few as possible, preferably only one protocol: TCP/IP. 
 
So, which protocol is best to use in a home network that connects just two or three PCs 
together? In general, try to use only one protocol. However, if required, multiple protocols can 
be installed, depending on whether or not you like to use Windows 98/Me/2000 Internet 
Connection Sharing or multiplayer games requiring a certain protocol.  
 

http://www.wown.com/j_helmig/tcpip.htm
http://www.wown.com/j_helmig/IP-address
http://www.wown.com/j_helmig/tcpip.htm
http://www.wown.com/j_helmig/tcpip.htm
http://www.wown.com/j_helmig/tcpip.htm
http://www.wown.com/j_helmig/tcpip.htm
http://www.wown.com/j_helmig/tcpip.htm
http://www.wown.com/j_helmig/tcpip.htm
http://www.wown.com/j_helmig/IP-address


 
 
The following protocol is advised: 
 

 If your network contains a Windows 2000 system, then you should use TCP/IP. 
 If your network contains a Windows XP system, then you must use TCP/IP. 

Binding Network Protocols 
A word or two on the network protocols and their usage on Network adapters. 
 
Look at the lines for Protocol. Sometimes protocols are listed multiple times, with the arrow "- >" 
pointing to different adapters: 



 

 
It shows you which protocol will be used with the different network adapters. This is called a 
"binding protocol." 
 
If you decide to communicate with the Internet using only TCP/IP, but you want to communicate 
with the local network using only NetBEUI, you simply "Add" the NetBEUI protocol provided by 
the manufacturer, Microsoft: 
 



 
When adding a protocol, Windows assumes that you want to use it to communicate with all 
defined network adapters. Select the unwanted combinations (in the example: NetBEUI on the 
Dial-up adapter and TCP/IP on the LAN) and click Remove: 
 

 



 

 
This system is now configured to communicate on the Dial-up Adapter (to the Internet) using 
TCP/IP protocol and on the local network (using the PCI Ethernet card) using NetBEUI. 
 
To adjust the Network configuration to your needs, delete everything that is not required.  
 
- Do you have a home network (or a company network) without a Novell Netware server? Then 
you have no need for Client for Netware Networks. Select it (single click) and "Remove" it. 
 
- Did you previously decide on the Network Protocol(s) to be used? For the protocols not 
required (or the "Bindings" = Combination of protocol to Network Adapter not required), select 
the lines listing the protocol and "Remove" them. 
 
(Example: If a home network is without a Novell server and there is no need to use IPX/SPX for 
games, delete it.) 
 
 

Step-by-Step Networking: Installing PCI Network Cards  
What should be a simple issue, but surprisingly often causes problems, is that when installing a 
network card, Windows needs to install the basic Network Components (such as Client and 
protocol) from the Windows setup files. While the first version of Windows 95 was still available 
on floppy disks, later versions of Windows (such as 98/Me/NT42000) are only available on CD-
ROM. But where are these floppies or where is this CD-ROM? Lost it? Never got it?  

Finding Windows Setup Files 
Check whether you need the original Windows floppies or CD-ROM. Some PCs came pre-
loaded with Windows on the hard drive disk and the installation started to run when the PC was 
powered on for the first time. On newer versions of Windows, such as Windows 98SE or Me, 
the installation procedure copies all setup files from the CD-ROM to your hard drive disk. 
 
Some people reconfigure their systems very often and tire of playing "disk jockey" in order to 
swap the Windows CD-ROM in and out. So they manually copy all setup files from the Windows 
CD-ROM directory WIN95, WIN98, WIN9X (or I386 in the case of Windows 2000 or Windows 
XP) to a similarly named directory on the hard drive disk. 



 
Note: If your system was installed from a recovery CD-ROM, there is a very good chance that 
the installation files are already on your hard drive disk. 

Windows 95, 98, and Me  
Check your system by selecting from the Start menu: Find > Files or Folders and search for 
"*.cab". Does it find "WINsomething.CAB" files? These are your Windows setup files. For 
example, here is an example of some Windows 98SE setup files, stored in 
"Windows\options\cabs": 
 
 

 
 

Windows 2000 and XP   
Check to see if you have the folder named "I386" on the hard drive disk. It will contain all 
installation files from the Windows CD-ROM. 

 
 
If you ONLY have such setup files on your hard drive disk, but no CD-ROM, you are strongly 
advised to make a backup copy for protection in case your hard drive disk crashes and you 
need to reinstall Windows! 
 
In addition, Windows must know the location of these setup files. This is established properly by 
the Windows setup procedure, but if you copied the Windows files yourself, you need to tell 
Windows this location. 
 



Now that you have located your Windows setup files (either on CD-ROM, floppies, or hard drive 
disk), you need the drivers for the specific network card that will be installed in the next step. 
 
You will most probably need a floppy disk or CD-ROM, which comes with your network card and 
contains the network driver. Before installing the network card, search the floppy disk or CD-
ROM to find your version of the Windows INF file. (Windows 95 also works for Windows 98.) 
The INF file is a text file that tells you which files need to be present or downloaded for your 
component to run, and includes the setup files. 
 
Please note the location of this INF file -- you will need it when you reboot your PC after 
installing the network card. 
 

 

Handling the Network Card 
Before installing the network card, there are some important things to be aware of when 
handling it.  
 

 

PCI Network card for a 
desktop computer 



 
Did this ever happen to you -- you reach out to touch something (such as the handle on a door) 
and a spark jumps from your hand to the handle? This is "static electricity" and it can damage 
computer boards! When walking on certain types of carpets and/or when cloth is moving on 
non-isolating materials, there can be a build-up of static electricity.  
 
The voltage can be very high, otherwise it couldn't cause a spark to jump through the air! But 
luckily the amount of the charge is very low, so it's only a minimal power flow from your hand -- 
just enough to give you a small shock. Such a spark would be very dangerous to the high-
density chips on modern computer boards, however, as it can destroy them! 
 
In the early days of computers, service engineers wore special bracelets that connected them to 
a metal part of the computer, to "ground" themselves in order to discharge any static electricity.  
(These bracelet connectors have not been in use for years and we have become a little sloppy 
with handling computer components. But the danger still exists!) 
 
To protect network cards against the risk of static electricity, they are usually packaged in a 
protective plastic bag. When removing the card from the plastic bag to install it in a computer, 
be sure to: 

 

 First, touch a metal part of your computer to discharge static electricity. 

 Avoid touching the chips on the board with your fingers!  

 Handle the card ONLY by its outer edges and do not touch the connectors. 
 

 
 
 Press the network card in using your thumbs and use pressure just on the top edge 

when you have to push it into the slot of the PC. 



Network Card Installation Procedures 
For a desktop computer you need to: 

1. Shut down Windows, power down your system. 
2. Disconnect the power cord (it's best to play it safe and avoid accidents!)  
3. Remove the outer casing of your computer. Usually the casing is held in place by a 

few screws. Once you remove the screws, carefully lift or slide off the casing. (Your 
PC manual should give you instructions on how to remove the casing on your 
particular computer.) 

 
Look at the back of your computer and you will see a row of long, narrow, covered slots.  
 

 

 
 
 
Some computers have two different kinds of slots -- 
PCI (Peripheral Component Interface) and ISA 
(Industry Standard Architecture). 
 
 In today's modern PC, there may be only one or two 
of the old ISA slots and on some PCs, no ISA slots 
at all.  
 
Most PCs use black connectors for ISA slots.   
 
 

 
Since ISA network cards have mostly disappeared from the market, it's fairly safe to assume 
that you have a PCI slot network card (most PCs use white connectors for PCI slots).  
 
The next step in the installation process is to remove the cover from one of the PCI slots (unless 
it has already been removed) to access the PCI card connectors.  
 



 

1. Remove the screw on the slot cover, 
set the screw aside and slide out the 
cover. 

2.  Handling the network card carefully, 
slide the network card inside the slot, 
lining up the connectors on the card 
with those in the slot. 
 

 3. When you have it all lined up, press 
down firmly on the top of the card until 
you hear it click into place. To make 
sure it is seated properly, you may have 
to gently apply some pressure, being 
careful not to bend the card. 
 

4. Secure the card into place using the 
screw that you removed from the slot 
cover. 

      

5.  Now that you have the network card 
installed, replace the casing on your 
computer and then connect the network 
cable. 
 

6. Reconnect the power cord. 

 
 
Now you are ready to power on your system for Windows to detect the new network card. 

Step-by-Step Networking: Installing Your Network Card Driver 



Display the Control Panel window and click System. Click on the Device Manager tab. It 
contains a list of all components of your PC.  
 
Since you can see and touch these parts, they are also called "hardware". But hardware on its 
own is useless, unless your system knows how to "talk to" and use the hardware. The computer 
requires some software, a program which allows the computer to use the hardware. Such 
software handling a piece of hardware is called a "device driver", often referred to as just 
"driver". 

Locating the Driver 
(On a Windows 2000/XP system, you need to logon as "Administrator" for this next step.) 
 
Once you have installed the new network card (a PC card/PCMCIA in a notebook computer or a 
PCI card in a desktop computer), Windows will detect the card. Windows will first display a 
message such as "PCI Ethernet Card detected" and then, depending on whether or not your 
version of Windows already has recognized the network card type, you will get one of the 
following responses: 
 

 
 
Windows identified the Network card and has a driver for it in its own library. 
 
It will immediately start installing the driver and other network components. If the Windows setup 
files are not stored on your hard drive disk, it will prompt you for the Windows CD-ROM. 
 
Windows could NOT identify the network card and does NOT have a driver for it:  
 



 
 
You are prompted to provide the floppy disk/CD-ROM provided by the manufacturer of the 
network card. Please verify that the path in "Copy manufacturer's files from" points to the correct 
location of the network drivers.  
 
If your Windows setup files are not stored on the hard drive disk, you also will be prompted for 
the Windows CD-ROM: 
 

 
 



Insert your CD-ROM, wait a few seconds to allow the CD-ROM to spin up and then click OK. If 
you get the window, Copying Files, then you need to verify that the path for "Copy files from" is 
correct and pointing to the location of the Windows SETUP files (either on the CD-ROM or on 
your hard drive disk). 
 

 
 
You will also get this message you clicked too quickly on OK when inserting the Windows Setup 
CD-ROM and the CD-ROM drive was not yet ready. 
 
Click OK again. 
 
Once Windows has copied the files, you will be prompted to restart your system. 
 



 

Confirming the Driver Installation 
Once the system has rebooted, check that the device driver for the network card has been 
installed and is working properly as follows: 

Windows 95, 98, and Me  
In Control Panel, double-click the System icon and select the Device Manager tab. 
 
Click on the "+" next to Network Adapters to display all installed adapters. 

Check that the following symbol is shown for the installed adapter:  
 
Click an adapter once to highlight it, then click the Properties button. Under "Device status" it 
should say, "This device is working properly". 
 
If there is no yellow mark or red cross on the adapter icon and if the device is listed as working 
properly, you are ready to continue to Adjusting Your Network Configuration for Windows 
95/98/Me. 
 



Windows 2000 and XP  
1. In Control Panel, double-click the System icon.  
2. Click on the Hardware tab, then click the Device Manager button in the Device 

Manager section. 
3. Click on the General tab. 
4. It should say, "This device is working properly". 

 
If there is no yellow mark or red cross on the adapter and if the device is listed as working 
properly, you are ready to continue to Adjusting Your Network Configuration for Windows 
2000/XP. 

Troubleshooting the Device Manager 
However, if "Device status" shows anything like what is shown below, then you need to start 
troubleshooting the Device Manager problem: 
 

 
 
First, verify the error code. Depending on the type of error code, you may need to install the PCI 
network card in a different PCI slot, or you may need to install a newer driver for the network 
card.  
 
 
 

Step-by-Step Networking: Adjusting Your Network 
Configuration for Windows 95/98/Me 
You now should have the icon for Network Neighborhood on your desktop. 
 
To display the Network Configuration dialog box, you can either right-click the Network 
Neighborhood icon and select Properties from the context/pop-up menu, or click the Network 
icon in the Control Panel window. 

Network Protocols 
Beginning with Windows 98, only Client for Microsoft Networks and the TCP/IP protocol will be 
installed. 
  
In Windows 95, the network card installation includes: 

- "Client for Netware Networks" 
- IPX/SPX compatible protocol 
- NetBEUI protocol 



 
 
 
This will require some cleanup. (If you would like to know why, have a look at Network Basics, 
explaining the flow of information and the logical connection between the components.) 
 
Note: There is no need to be concerned about making mistakes in the Network Configuration: 
 



  
 
If you made a mistake and deleted too much (or you think you made a mistake), exit the 
Network Configuration by selecting Cancel. That way, none of your changes in the Network 
Configuration will be stored. This allows you to start again and make modifications.  
 
If you need to, you can easily start all over again:   
 

 Select the PCI network card and click on the Remove button to delete it. 
 Then exit the Network Configuration by selecting OK. You will be prompted to reboot.  

 
When you reboot, Windows will detect the network card, allowing you to start the configuration 
again. 
 
 

Step-by-Step Networking: Adjusting Your Network 
Configuration for Windows 2000/XP 
There are several methods used to display the Network configuration dialog box, via:  

- Settings > Network and Dial-up Connection 
- Desktop > My Network Places > Properties 
- Control Panel > Network and Dial-up Connection 



Network Protocols 

Windows 2000  
In the Network and Dial-up Connections window, you set up the configuration of the local 
network (Local Area Connection) and of any dial-up Networking connection (such as a modem 
connection to the Internet): 
 

 
 
To view/modify the Network configuration, right-click and select Properties which will be listed  
on the context/pop-up menu): 
 



 
 
By default, all required Components for a network between Microsoft Windows systems are 
installed using TCP/IP protocol. Since TCP/IP is the Windows 2000 default protocol, you are 
strongly advised to use it. Do not delete it! If you have Windows 95/98/Me systems on your 
network, you should also configure them for TCP/IP). 

Windows XP  
Now you will adjust the local Network configuration (Local Area Connection) and that of any 
dial-up Networking connection (such as a modem connection to the Internet): 
 



 
 
To view/modify the Network configuration, right-click to display Properties: 
 

 



 
As in Windows 2000, all required components for a network between Microsoft Windows 
systems are installed by default using TCP/IP protocol.  
 
Since TCP/IP is the default protocol in Windows XP, and NetBEUI is no longer supported, you 
will have to use it. If you have Windows 95/98/Me systems on your network, you should also 
configure them for TCP/IP. 
 
Windows XP Professional contains a new service, the QoS Packet Scheduler. Just leave it 
there. 
 
If you need another protocol (example: NetBEUI to network to a DOS system), then click the 
Install button to display Select Network Component Type. Select Protocol, then Add for more 
components, such as IPX/SPX or NetBEUI. 
 
(NetBEUI protocol is only available on Windows 2000; it is not available on Windows XP.) 
 

 

NetBEUI 
Nothing to configure. 

IPX/SPX  
On a network WITHOUT a server, you need to define the frame type. 

TCP/IP  
If you first had a look at TCP/IP basics, you should know what you are now configuring. Usually 
it's just the IP address, as you should have defined already: 
 



 
 
Select TCP/IP and click the Properties button. 
 
By default, your system is configured to "obtain an IP address automatically"  
(via a DHCP server or  Windows 2000 Auto-IP configuration). 
 
Select "Specify an IP address" and enter your IP address (usually it is 192.168.0.1), then define 
as Subnet Mask : 255.255.255.0. 
 
For a simple home network, this is all that is required.  
(Windows 2000 Internet Connection Sharing ICS will require more work).  
 



 
 
Verify/Define the names for the computer and workgroup. 
 
You have already decided on the names for your computer and for your workgroup. Verify these 
names in Network Identification, which is part of the properties of My Computer on the desktop 
or in System via the Control Panel. 
 
Select the tab:  

- Computer name (Windows XP) or 
- Network Identification (Windows 2000) 

 
and verify your Full Computer name (which must be unique on the network) and your 
Workgroup name (which must be identical on all systems). 
 
To change these names: 

- click Properties (Windows 2000) or 
- click Change (Windows XP). 

  



 
 
For a simple network of Microsoft Windows PCs without an NT4 server or a Windows 2000 
server defining a Domain, you need to select Workgroup and define a workgroup name, which 
must be identical on all systems on your network. 
 
File and Printer Sharing: 
 



 
 
 

Step-by-Step Networking: Testing Your Network Connection 
Have you installed the network card and have you verified in the Device Manager that the 
Network card is listed as working properly? Have you adjusted the Network Configuration and 
configured the Network Protocols?  

Windows Diagnostic Tools 
Before attempting to access data on the other system, you are strongly advised to use the 
Diagnostic tools provided with Windows to verify that the electronics on the network card are 
working and the cabling is in good condition. 
 
There is no menu function to select, no option to be selected, no button to be pushed, so you 
will need to use an MS-DOS Prompt or Command Prompt. 
 



 

Using MS-DOS Commands  
Less experienced computer users very often have no knowledge of DOS commands. You may 
find the following list of MS-DOS commands to be helpful. One of the most powerful commands, 
and at the same time, least known, is "NET". NET is a useful DOS command that provides help 
when you ask for it, via: NET > help: 
 

 
 
 
(This actually takes more than one window to display. The above image is the result of 
combining two screens in order to display the complete interface.) 



Windows 95, 98, and Me   
Windows 95/98 still uses MS-DOS Version 7 to start the boot-up process before switching over 
to the graphical user interface. 
 

 
 
Some tasks can be better accomplished using a DOS command, so Windows offers this option 
in the MS-DOS Prompt window (often also called a "DOS box"): 
 

 



Windows 2000 and XP  
In Windows 2000/XP you will need to use the  
Command Prompt" via Start menu > Programs > Accessories. 

NetBEUI and/or IPX/SPX Protocol 
Can you find the option "NET DIAG" in the above MS-DoS list? This requires Windows 
95/98/Me on both systems.  
 
(This diagnostics is not available on Windows 2000/XP; please use PING.) 

NET DIAG   
NET DIAG runs the Microsoft Network Diagnostics program to display diagnostic information 
about your network. 
 
At the prompt, type: "net diag". 
 

 
 
If multiple protocols are installed, select the one to be used for the test. 
Since this is the first system running the test, there is no answer from the network.  
 
Answering now with 'N' will have the system act as 'Diagnostic Server'. 
 
On the other system(s), also enter a DOS window and again type: "net diag". 
 



 
 
Again, define the protocol, if you are asked for it. 
 
If the network hardware is in good condition, the "net diag" on this station should now locate the 
Diagnostic Server on the other system and display a message like that above. This means you 
are ready to continue with the next step of the network setup. 
 
However, if you are asked again whether the "Diagnostic server is already running", it means 
there was no communication and you need to troubleshoot your hardware and cabling. 

TCP/IP Protocol 
The TCP/IP protocol comes with its own diagnostic utility, called PING. 
 
As soon as you install TCP/IP protocol, it automatically installs a diagnostic responder (so there 
is no need, as with NET DIAG, to install a Diagnostic Server first). Any system configured with 
TCP/IP (a PC, a UNIX system, a mini-computer, a network printer, for example) has this 
diagnostic responder and will reply to the PING signal. (An exception to this is that systems with 
a firewall may not respond to a PING signal.) 
 



 
 
Did you configure the IP address in the previous step? At the prompt, type "PING 192.168.1.1", 
where 192.168.1.1 in this example is the IP address of system #1 on a small network. 
 
In this example, a reply coming back, a network signal passed through the network card on the 
network cable via the network card on the other system, and was then sent back the same way. 
This verified that the electronics of the network card is working and the cabling is correct. 
 
Be sure to run this test on all systems on your network and PING all other systems! It is possible 
that a system can send out PING signals and receive the return signal, yet itself is NOT 
responding to a PING signal. (This can be caused by personal firewalls.) 
 
If you get all networked systems to reply, then you are ready to continue. 
 
In the following example, trying to "PING 192.168.1.3" results in no answer: 
 



 
 
A signal was sent out to contact it, but there was no reply. (In this example, it is because there is 
no system #3 with IP address 192.168.1.3.) 
 
If you have a system configured with this IP address and it is powered on and  
connected to the network cable, but you get no PING reply, it means that you need to start 
troubleshooting. (If you used a personal firewall, then it is probably not configured properly). 
 
Note: If PING does not work in all directions, then the NetBIOS broadcasts also will be failing, 
and since all Microsoft networking (except the new Active Directory on Windows 2000 server) is 
based on NetBIOS, your network will not work properly. 
 

Step-by-Step Networking: Sharing Access to Windows 
95/98/Me Resources  
This section is only for Windows 95/98/Me as there are slightly different procedures for 
Windows 2000/XP Professional and for XP Home. 
 
You already have installed your network card and checked the network configuration. Now the 
question is, do you only want to connect from your system to another computer on the network 
or do you want also to allow other computers to access resources on your system? (A network 
resource is either an entire disk, a folder with all files and subdirectories, or a printer.) 
 
For other computers to access your system, you should already have installed File and Print 
Sharing as part of the check/adjusting of the network configuration. Once File and Print Sharing 



is installed, you need to decide which parts of your computer other systems should be able to 
access, or to put it another way, which part of your system to share. 
 
You can allow access to an entire hard drive disk on your computer or to only a folder. You also 
can allow other systems to print from your printer. 

Sharing a Hard Drive Disk  
In My Computer, right-click on the hard drive disk to be shared and select Sharing from the 
context/pop-up menu: 
  

 
 
The system displays the Properties of the hard drive disk, with the Sharing tab pre-selected. By 
default, the hard drive disk is not shared. 
 



 
 
Select the hard drive disk to be "Shared As...", define the Share Name, which will be the name 
of this hard drive disk on the network (include no blanks, and use as short a name as possible). 
 
You can decide the level of access; the other system can be limited to Read-Only data from 
your hard drive disk, or have Full permission (to read/write/delete files). 
 
If you trust everybody on your network, you have no need for passwords, but if there are some 
systems not allowed access to your data, you do need to create a password. 
 
Once a hard drive disk is shared, the symbol in My Computer changes to a hand holding the 
hard drive disk. 
 



 

Sharing a Folder 
If you do not want to allow access to your entire hard drive disk, you can allow access to (share) 
only a folder. Other systems then can see only the files and sub-folders within this folder. 
 

 
 
Select the folder to be shared, right-click and select Sharing from the context/pop-up menu.  
 
As in sharing an entire disk, select "Shared As...", define the Share Name, the access type, and 
a password, if required. Once a folder is shared, the Folder symbol changes to a hand holding 
the Folder. 

Sharing a Printer 
In Printers, via My Computer or via Control Panel, right-click on the printer  
to be shared and select Sharing from the context/pop-up menu.  
 
The system displays the Properties of the printer with the Sharing tab pre-selected. 
 



By default, a printer is not shared. 
 
Select "Shared As....", and define a Share Name under which the printer will be listed in 
Network Neighborhood. 
 

 
 
Once a printer is shared, the symbol in Printers changes to a hand holding the printer: 
 

 
 



Step-by-Step Networking: Sharing Access to Resources in 
Windows 2000/XP Professional  
This section is only for Windows 2000/XP Professional Edition. There are slightly different 
procedures for Windows 95/98/Me and Windows XP Home Edition. 
 
First you need to log on as Administrator or Standard User (Power User) for this step. 
 
You already have installed your network card and checked the network configuration. 
 
Now the question is, do you only want to connect from your system to another computer on the 
network or do you want to allow other computers also to access resources on your system? (A 
network resource is either an entire hard drive disk, a folder with all files and subdirectories, or a 
printer.) 
 
Unlike Windows 95/98/Me, where you need to install File and Print Sharing as part of the 
check/adjusting of the network configuration, Windows 2000/XP has File and Print Sharing 
installed by default. 
 
You need to decide which parts of your computer other systems should be able to access, or to 
put it another way, which part of your system to share. 
 
You can allow access to an entire hard drive disk on your computer or to only a folder. You also 
can allow other systems to print from your printer. 
 
In Windows XP, Microsoft has changed the method for sharing a hard drive disk or folder to a 
new method that is designed specifically for the Windows XP Home Edition. 
 
In the Windows XP Professional Edition, you can select: 

 to use the Simple File Sharing (as designed for XP Home) or 
 to switch off Simple File Sharing 

 
Note: By default, Simple File Sharing is activated in Windows XP Professional. 
 
Open My Computer and select Tools from the menu to display "Folder Options...". 
 
Select the View tab, and then Advanced settings. 
 
Uncheck the Simple File Sharing option to deactivate it, as shown: 
 

 
 
 
If you do not deactivate Simple File Sharing, then you have to make your sharing work the way 
it does in Windows XP Home.  
 
Windows XP Professional File Sharing will now work the way it does in Windows 2000. 



Sharing a Hard Drive Disk 
In My Computer, right-click on the hard drive disk to be shared and select Sharing from the 
context/pop-up menu. 
 
The system displays the Properties of the hard drive disk, with the Sharing tab pre-selected. 
 
By default, a Windows 2000 hard drive disk is already shared, using "C$", "D$" as the share 
names. This is the Administrative Share, used in company networks to allow a network 
administrator access to your system. It is not visible in Network Neighborhood. (See Hidden 
Shared Resources.) Do not delete this share! 
 

 
 
Click the New Share button. 
 
Define the Share Name, which will be the name of this hard drive disk on the network (use no 
blank spaces, and use as short a name as possible): 
 



 
 
Warning: if the name is more than 12 characters, it will not be displayed in the Network 
Neighborhood of a Windows 95/98/Me system. 
 

 
 
 
Click the "Permissions..." button. 
 
You can decide on a level of access that will allow other users to Read data from your hard 
drive disk, or to have Full Control (to read/write/delete files). 
 
By definition, these levels of access are assigned for the User group, Everyone, which is a 
hidden user group and includes all users defined on this system. 
 

 
 
Only users with a username defined on this system will be able to connect! You have the ability 
to add other User Groups or Usernames to this list and assign different access levels to each of 
them. 
 



 
 
Back on the Sharing tab, you now can select one of the following for Share name: 
 

- the Administrative Share (such as C$ ) 
- the user-defined Share name 

 
Exit with OK to make this definition valid.  
 
Once a hard drive disk is shared, the symbol in My Computer changes to 
a hand holding the hard drive disk: 
 



 

Sharing a Folder  
If you do not want to allow access to your entire hard drive disk, you can allow access to (share) 
just a folder. Other systems then can see only the files and sub-folders within this folder. 
 
Select the folder to be shared, right-click and select Sharing from the context/pop-up menu.  
 
As in sharing an entire disk, select "Shared As...", define the Share Name, the access type, and 
a password, if required. Once a folder is shared, the Folder symbol changes to a hand holding 
the Folder. 

Sharing a Printer 
In Printers, via My Computer or via Control Panel, right-click on the 
printer to be shared and select Sharing from the context/pop-up menu. 
 



 
 
The system displays the Properties of the printer with the Sharing tab pre-selected. 
 
By default, a printer is not shared. 
 
Select "Shared As....", and define a Share Name under which the printer will be listed in 
Network Neighborhood. 
 
Once a printer is shared, the symbol in Printers changes to a hand holding the printer: 
 

 
 
 



 
 
Check that you performed the operation properly.  Look in My Network Places in Computers 
Near Me under your own Computer name. It should now list all items shared in the steps above. 
 

 
 

Step-by-Step Networking: Sharing Access to Resources in 
Windows XP Home  
This section is for Windows XP Home Edition or Windows XP Professional Edition using Simple 
File Sharing. There are slightly different procedures for Windows 95/98/Me and for  Windows 
2000 and Windows XP Professional Edition, not using Simple File Sharing. 
 
First you need to log on as Administrator or Standard User (Power User) for this step. 
 
You already have installed your network card and checked the network configuration. 

Choosing Access Options 
Now the question is, do you only want to connect from your system to another computer on the 
network or do you want to allow other computers also to access resources on your system? (A 



network resource is either an entire hard drive disk, a folder with all files and subdirectories, or a 
printer.) 
 
Unlike Windows 95/98/Me, where you need to install File and Print Sharing as part of the 
check/adjusting of the network configuration, Windows XP has File and Print Sharing installed 
by default. 
 
You need to decide which parts of your computer other systems should be able to access, or to 
put it another way, which part of your system to share. 
 
You can allow access to an entire hard drive disk on your computer or to only a folder. You also 
can allow other systems to print from your printer. 
 
In Windows XP, Microsoft has changed the method for sharing a hard drive disk or folder to a 
new method, called Simple File Sharing.  
 
In the Windows XP Home Edition, you must use Simple File Sharing. 
 
In the Windows XP Professional Edition, you can switch off Simple File Sharing, or you can 
select to use Simple File Sharing (as in XP Home).  
 
To share a hard drive disk (as, for example, in My Computer), right-click the hard drive disk icon 
to get the context/popup menu and select "Sharing and Security...". 
 

 
 
Compared to previous versions of Windows, Microsoft has included much more information to 
warn users about security issues. Here is an example: "Sharing an entire hard drive disk can be 
a security problem." 
 
Sharing only folders is more selective and not such a high security risk. Once you have selected 
the folder to be shared, either right-click to get the context/pop-up menu and select Sharing and 
Security, or select from the File and Folder Tasks (on the left side) to "Share this folder." 
 



 
 
In previous versions of Windows, it has been sufficient just to have File and Print sharing 
installed to be able to share. In Windows XP, you are recommended first to run the Network 
Setup Wizard. 
 

 
 
If you know how to set up the firewall, you can choose to share files without running the Network 
Setup Wizard. Confirm again that you just want to enable File Sharing and you will skip the 
Setup Wizard. However, if you are new to networking and not sure about security issues, it's a 
good idea to use the Network Setup Wizard. 
 

http://www.wown.com/j_helmig/guidshrh.htm
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Once you have run the Network Setup Wizard, the checkbox to share becomes active. 
 
Once a hard drive disk or folder is shared, the icon will show it via the "holding hand" icon. 

 

Step-by-Step Networking: Using Network Neighborhood or 
My Network Places 
Once you have permitted access to your resources via the network for Windows 95/98/Me 
and/or permitted access to your resources (Sharing) for Windows 2000/XP/XP Home and XP 
Professional, you can access the network. Make sure that you log on to the system using the 
Network logon (Enter Network Password): 
 



 
 
If you pressed the ESC key or clicked Cancel, then you did not validate your network user name 
and will not have access to the network! 
 
It is not sufficient to just log on to Windows (Enter Windows Password). This does not result in a 
logon to the network software, and will not allow you to use the network! 
 
If you intend to access data on a Windows 2000/XP system, then you must make sure that the 
User name (and password) used during the Windows 95/98/Me/2000/XP startup is identical to 
the User name (and password) defined in User Management of the Windows 2000/XP system 
to which you want to connect. 
 
Just as, when going to work on your computer, you need to enter your user name, a connection 
via the network requires identification!   

Logon for Windows 95, 98, and Me 
You can obtain network access via the "Network Neighborhood" icon on your desktop:  

 
 
If you get a request for the IPC$ resource when trying to access resource sharing on a Windows 
2000 or XP system, then the user name and password entered during startup is not defined, or 
does not match a user name exactly as defined in User Management. 



 

 



 

Logon for Windows 2000   
You can access network resources via the My Network Places icon on your desktop:  

 
 
Select Computers Near Me: 
 

 
 
Now select  the system to which you'd like to connect, for which all shared resources will be 
displayed: 
 



 

Logon for Windows XP  
You can access network resources via the My Network Places icon on your desktop:  
 

 
 
Windows XP will show you all shared resources on the network to which you have access. 
 
You can also view the computers in the workgroup by selecting "View workgroup computers", 
under Network Tasks: 
 



 
 
The names of the available resources are the Share names. You now can use any Windows 
Explorer function to copy/paste/delete files. 
 
Important: Only systems with File and Print Sharing installed and with something shared will be 
displayed in Network Neighborhood. 
 
If only your own system is shown, see the next section on how Network Neighborhood works. 
 

 
 
 
You can also access Network Neighborhood from the File > Open menu of most Windows 
programs. 
 



On some programs, the File > Open menu does not offer to browse the Network Neighborhood. 
In such cases you need to map a network drive. 

Mapping a Network Drive 
Note: Due to the design of Microsoft Networking based on a Browse Master, it may take a few 
minutes after a reboot of the system before the network drive shows up in Network 
Neighborhood. 
 
How does Network Neighborhood work? It's worth spending the time to learn about this, as it 
explains its sometimes confusing behavior. 

Browse Master  
On a network based on Microsoft networking, there must be one system acting as the 
bookkeeper; this system is called the "Browse Master". The Browse Master is a computer on 
the network that keeps an active list of all the computers in the workgroup. When you have a 
network of Windows 95/98/Me systems and you switch on these systems, one of first things 
done by the network software is to check on the network for the presence of a Browse Master: 
 

 If no Browse Master is found, then a Browse Master is elected.  

 
 Only a system with File and Printer Sharing installed can be elected to become a 

Browse Master 
 On a network with a mixture of Windows 95/98 and Windows NT/2000 systems, only a 

Windows NT or Windows 2000 system can become the Browse Master 
 On a network with a Windows NT server, the NT server becomes the Browse Master 
 Each system sends the list of available shared resources to the Browse Master 

 
 



If you use Network Neighborhood to view the list of available resources on the network, then 
your system sends a request to the Browse Master, which sends back the list of the available 
resources for display. 
 

 
 
This should help you understand some of the confusing behavior of Network Neighborhood. 
 
Your own system does not have File and Printer Sharing installed, your system could not find a 
Browse Master on the network: 
 

 
 
 
 
 
 
 
 
 
 



If your own system has File and Printer Sharing installed, only your own system is displayed, 
not any other system on the network: 
 

  
 
First, after switching on Windows, it can take a few minutes to elect the Browse Master. It may 
help to close Network Neighborhood and open it again after a few minutes. Second, when a 
system is switched on or off later, it can take up to 15 minutes before the display list of the 
Browse Master is updated. 
 
If you are still not getting a proper display, then check the following: 
 

 Verify that all systems are defined to use the same workgroup. 
 Only systems with File and Printer Sharing installed and something shared are 

displayed. 
 Test the network connection. 

Locating the Browse Master  
On networks using TCP/IP protocol, you can find out which system is acting as Browse Master: 
 



 
 
If you want to decide which system will act as the Browse Master, view the Properties of File 
and Printer Sharing. By default, the setting for Browse Master is Automatic, which is why the 
systems have elected a Browse Master.  
 
You can name a system to be the Browse Master by changing the Browse Master value to 
Enabled, but then you must change the value to Disabled on all other systems in this 
workgroup. 
 
 
Note: Be sure to visit http://www.wown.com for even more detailed networking tips, tricks, 
troubleshooting tips, and DETAILED network setups. This site has plenty of information for you! 
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